
Multi-Net® II OPERATOR’S

MANUAL
NETWORK

MANAGEMENT

FOR SIMULCAST
Part No. 002-0690-201 6-97 Printed in U.S.A.





Copyright© 1997 by E.F. Johnson Company

E.F. Johnson Company designs and manufactures two-way radio equipment to serve a wide variety of communications needs. E.
Johnson Company produces equipment for the mobile telephone and land mobile radio services which include business, industria
ernment, public safety, and personal users. 
Multi-Net® II
Network Management For Simulcast

Operator’s Manual

F. 
l, gov-

LAND MOBILE PRODUCT WARRANTY

The manufacturer's warranty statement for this product is available from your product supplier or from the E.F. Johnson Company, 299 
Johnson Avenue, Box 1249, Waseca, MN 56093-0514. Phone (507) 835-6222.

WARNING

DO NOT allow the antenna to touch or come in very close proximity with the eyes, face, or any exposed body parts while the radio is 
transmitting.

DO NOT operate the transmitter of a mobile radio whena person outside the vehicle is within one (1) meter of the antenna.

DO NOT operate the transmitter of a stationary radio (base station, repeater or marine radio) when a person is within one (1) meter of 
the antenna.

DO NOT operate the radio in explosive or flammable atmospheres.  The transmitted radio energy could trigger blasting caps or cause 
an explosion.

DO NOT operate the radio without the proper antenna installed.

DO NOT allow children to operate or play with this equipment.

NOTE: The above warning list is not intended to include all hazards that may be encountered when using this radio.

This device complies with Part 15 of the FCC rules.  Operation is subject to the condition that this device does not cause harmful inter-
ference.  In addition, changes or modification to this equipment not expressly approved by E.F. Johnson Company could void the user's 
authority to operate this equipment (FCC rules, 47CFR Part 15.19).

SAFETY INFORMATION

Proper operation of this radio will result in user exposure below the Occupational Safety and Health Act and Federal Communication 
Commission limits.

The information in this document is subject to change without notice.

E.F. Johnson Company will not be liable for any misunderstanding due to misinformation or errors found in this document.

LTR, LTR-Net, Multi-Net, Viking Head/EFJohnson Logo, Call Guard and  SUMMIT are registered trademarks of E.F. Johnson Company  
All other company and/or product names used in this manual are trademarks and/or registered trademarks of their respective manufac-
turer.





TABLE OF CONTENTS
1 INTRODUCTION

1.1 SCOPE OF MANUAL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1
1.2 CONVENTIONS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1
1.3 DEFINITION OF TERMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-1
1.4 STARTING THE PROGRAM. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-2
1.5 OVERVIEW OF MANAGING AN E.F. JOHNSON NETWORK. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-2

2 ALARMS

2.1 A BEEP OR SOUND FILE PLAYS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-1
2.2 THE ALARM BELL IN THE TOOLBAR CHANGES COLOR . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-1
2.3 MAP ICONS CHANGE COLOR . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-1
2.4 MAP VIEWING OPTIONS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-2
2.5 AN ENTRY IS DISPLAYED IN THE ALARM LOG . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-2

ACCESSING THE ALARM LOG  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2
DESCRIPTION OF THE ALARM LOG. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3
DISPLAYING CURRENT OR HISTORY LIST  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3
ACKNOWLEDGING ALARMS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3
DISPLAYING SELECTED GROUPS (FILTER DIALOG BOX) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-3
DESCRIPTIONS OF THE ALARMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-4

2.6 COLOR STATUS LEGEND . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-4
2.7 ACTIVE REPEATER ALARMS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-4

3 POLLING

4 RECOVERY (REVERTS)

4.1 CONSIDER INTERFERENCE PROBLEMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-1
4.2 CONSIDER STATUS CHANNEL AND HOME CHANNEL ACCESS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-2
4.3 MANUALLY UNREVERT AND REVERT CHANNELS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-3
4.4 CHANNEL UNREVERT EXAMPLES  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-3
4.5 MANUALLY UNREVERT AND REVERT SITES . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-4
4.6 SITE REVERT EXAMPLE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-4
4.7 PERFORM MANUAL REPEATER CONTROL  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-6
4.8 REPEATER MENU . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-6

5 OPENVIEW OPTIONS

5.1 LOG IN AND LOG OUT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-1
5.2 PROTECT/UNPROTECT MAP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-1
5.3 CUSTOMIZING OPENVIEW . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-1
5.4 CUSTOMIZING ALARMS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5-1

ALARMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-1
ALARM SOUND. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-1
STATUS PROPAGATION . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-2
ALARM FORWARDING . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-2
i



TABLE OF CONTENTS (CONT.)
6 TROUBLESHOOTING

6.1 PING . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-1
PING TROUBLESHOOTING TECHNIQUES . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-1
PING PROGRAM OPERATION. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-1

6.2 E.F. JOHNSON ALARMS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-2
REPEATER GENERATED ALARMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-2
SITE/CHANNEL COMPUTER GENERATED ALARMS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-2
HOST COMPUTER GENERATED ALARMS (FOR THE SITE/CHANNEL COMPUTERS) . . . . . . . . . . . . . . . .  6-3
HOST COMPUTER GENERATED ALARMS (FOR THE REPEATERS) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-3
HOST COMPUTER GENERATED ALARMS (FOR A SYSTEM). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-3

6.3 MNEMONICS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-3

LIST OF FIGURES
1-1 BLOCK DIAGRAM OF TYPICAL SYSTEM  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-3
4-1 REVERTED SITES CAN CAUSE INTERFERENCE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-1
4-2 RELATIONSHIP OF REPEATERS, CHANNELS, AND SITES. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-2
4-3 SITE 3 IS CONFIGURED TO REVERT TO A STAND-ALONE MULTI-NET SITE.  . . . . . . . . . . . . . . . . . . . . . .  4-5
6-1 TROUBLESHOOT BY PINGING SEVERAL IP ADDRESSES . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-1

LIST OF TABLES
2-1 ICON DESCRIPTIONS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
2-2 ICON AND MAP COLORS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-5
ii



INTRODUCTION
SECTION 1   INTRODUCTION
1.1 SCOPE OF MANUAL

This manual covers the functions of HP Open-
View and the E.F. Johnson application that are avail-
able when logged on with the operator password. 
Alarms can be monitored and acknowledged, and 
some program options can be set. Access to a com-
puter running OpenView and the E.F. Johnson applica-
tion as well as familiarity with Windows® NT and 
networks are assumed. If menu selections and options 
are available that are not covered in this manual, con-
sult with the System Manager before using them.

1.2 CONVENTIONS

Menu item selections are written similar to:
Monitor -> Status Legend
This example means to pull down the Monitor menu 
and select the Status Legend item.

Ctrl+click means to press the Control key (nor-
mally labeled Ctrl) while clicking the mouse on the 
desired location.

Keyboard shortcuts are written similar to:
Ctrl+Alt+Del
Ctrl+S
Press and hold the keys in the order written and then 
release all keys. Each keyboard key is separated by a + 
sign. Example: Ctrl+S means press and hold the Ctrl 
key, press the S key, then release both keys.

1.3 DEFINITION OF TERMS

Multi-Net Signaling - The format of the data mes-
sages that are used to control trunking. Data messages 
contain over-the-air instructions, or update informa-
tion, about incoming calls and free channels. Multi-
Net signaling also provides many enhanced operating 
features such as unique ID calls and access priority.

Multi-Net System - A trunked radio system that uses 
E.F. Johnson Multi-Net signaling. Other types of sig-
naling can also be used. A Multi-Net system can be 
one site or multi-site. Each site uses a different set of 
channels and radios can be trunked between sites.

Network Management - A computer system that 
monitors the radio system for significant events. These 
events are sent to a host computer where they can be 
responded to manually, or in some cases automatically.

Reverts - Actions that are automatically performed if 
failures occur. These actions are configured and per-
formed through network management.

Simulcast - A transmission method where several 
sites that have overlapping coverage areas use the 
same channels. All sites have a repeater on each chan-
nel. All repeaters on the same channel are synchro-
nized so they will transmit the same message at the 
same time and phase.

Simulcast System - A system whose transmission 
method is simulcast and whose trunking method is 
Multi-Net signaling. Simulcast systems are also moni-
tored by network management.

Site - Repeaters and/or other network equipment that 
is physically located together. Each site includes one 
computer that is part of the network management sys-
tem. Sites can be collocated.

Stand-Alone Multi-Net Site - A site that uses Multi-
Net signaling, but will not trunk to other sites that use 
Multi-Net signaling. None of the enhanced operating 
features provided by Multi-Net signaling are available 
at these sites.

Trunking - The automatic sharing of channels in a 
multiple repeater system.
1-1
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INTRODUCTION
1.4 STARTING THE PROGRAM

1. Turn on the computer and monitor. The computer 
will boot up and display a Welcome window.

2. Press Ctrl+Alt+Del to log on. Another Welcome 
window displays.

3. Verify username, enter password, and press return. 
The HP OpenView log-in window displays.

4. Choose Operator security level, enter the password, 
and press return. The OpenView application starts, 
displays its menus, and displays a Home map of the 
network system.

OpenView is in the startup group and will auto-
matically start when the computer is turned on. To 
start OpenView while Windows NT is running, the 
OpenView application is stored in the OpenView Pro-
gram Group of the Program Manager.

1.5 OVERVIEW OF MANAGING AN E.F. 
JOHNSON NETWORK

An E.F. Johnson Network is a system that enables 
remote repeater sites to report significant events to a 
host computer, where the events can be managed. The 
host computer runs the HP OpenView program and an 
E.F. Johnson proprietary application, which together 
use alarms to report significant events. The alarms are 
reported to the screen of the host computer by chang-
ing the color of map icons and by displaying an entry 
in an alarm log. The operator can then decide how to 
respond to the alarms. In addition, the system can be 
configured to automatically manage some alarms.

Figure 1-1 shows a typical central and remote 
site. There may be several other remote sites of similar 
configuration.

The remote sites communicate to the host com-
puter (often located at the central site) via DS0 links 
(64 K bps). In this diagram, the DS0 link is part of the 

microwave link that carries other information between 
sites. Within a site, network components capable of 
TCP/IP are connected with 10BaseT Ethernet®. The 
site/channel computers are also connected by a serial 
link to MBCs (Message Bridge Cards) in the repeaters 
and channel controllers. E.F. Johnson proprietary soft-
ware is used to communicate between the computer 
and MBC; then, the computers pass the information 
via TCP/IP to the host computer.

Alarms arrive at the host computer through sev-
eral means. Computers and routers can be polled by 
the host computer on a regular basis to determine if the 
network link is functioning. Routers will send SNMP 
(Simple Network Management Protocol) trap mes-
sages to the host computer when a significant event 
occurs. The E.F. Johnson proprietary software will 
send messages to the host computer when significant 
events occur in repeaters and channel controllers. 
Repeaters and channel controllers also have IACs 
(Interface Alarm Cards) that can report external 
alarms, such as open doors. These alarms are also 
reported through the E.F. Johnson proprietary soft-
ware.

Some alarms will correct themselves. For exam-
ple, if a door opens, an alarm will be received that the 
door is open. When the door closes, an alarm will be 
received that the door has closed.

Some alarms can be configured to be managed 
automatically by the system. These are called Reverts. 
For example, if a critical alarm reports that one 
repeater is not working, the system could be config-
ured to automatically shut down all repeaters on that 
channel. The problem is not corrected, but it is man-
aged. It is not a perfect solution, but it may be the best 
solution for the circumstances. The critical alarm still 
exists, in fact more of them exist because more repeat-
ers are not working. However, the system may be 
more useful without one channel, than with a large 
hole in the coverage of one channel.

Other alarms will have to be handled manually. If 
a door opens but does not close and no one is supposed 
to be at the site, the police may need to be called to go 
see who is there. If a storm takes out an entire site, 
some major work will need to be done.
1-2
June 1997
Part No. 002-0690-201



INTRODUCTION
Figure 1-1   BLOCK DIAGRAM OF TYPICAL SYSTEM
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ALARMS
SECTION 2   ALARMS
OpenView receives periodic status messages 
from devices. When a device reports a problem, the 
operator is notified of an alarm by the following 
events.

• A beep or sound file plays.
• The Alarm Bell in the toolbar changes color.
• Map icons change color.
• An entry is displayed in the Alarm Log.

2.1 A BEEP OR SOUND FILE PLAYS

Alarm sounds are configurable by the operator. 
(See Section 5.4.2 Alarm Sound.) Depending on con-
figuration, when an alarm occurs there may be no 
sound, a simple beep, or a sound from a sound file. 
Each level of alarm may have a different sound. The 
sound may occur only once or it may repeat until 
alarms above a specified status level are acknowl-
edged.

2.2 THE ALARM BELL IN THE TOOLBAR 
CHANGES COLOR

The Alarm Bell icon in the toolbar will change 
color to indicate the status of the alarm.

NOTE: If a higher-level alarm exists, the Alarm Bell 
will not change color, but will stay the color of the 
highest-level alarm.

To view the color legend, select menu item Moni-
tor -> Status Legend.

Clicking on the Alarm Bell button will display 
the Alarm Log. The Alarm Log is described later in 
this section.

2.3 MAP ICONS CHANGE COLOR

When an alarm occurs, maps show the location of 
the alarm by changing the color of the icons where the 
alarm occurred. To view the color legend, select menu 
item Monitor -> Status Legend.

When OpenView starts, a map is displayed. This 
map is typically the home map and will show a System 
icon for each system. Double-clicking on a System 
icon will display a submap that shows Site icons for 
each site within the system. Double-clicking on a Site 
icon will display a submap with icons for all moni-
tored devices (repeaters, routers, etc.) at that site.

When the status of a device changes, its icon 
changes color to indicate the current status. The Sys-
tem and Site icons associated with the device also 
change color, unless they are already colored for a 
higher-level alarm. (System and Site icons can be con-
figured to not change color. See Section 5.4.3 Status 
Propagation.)

To display the Alarm Log for a specific icon, 
move the cursor over the desired icon, click the right 
mouse button, and select Alarms. The Alarm Log will 
show only the alarms for that icon. To have the log 
show all alarms, click the Alarm Bell in the toolbar.

NOTE: Viewing the alarms of a System or Site icon 
will only show network-level alarms (not alarms for 
all devices at that location).

Maps can also be viewed by selecting menu item 
Window -> Home Submap or Window -> Locate Sub-
map. Specific icons can be located by selecting menu 
item Window -> Locate Object.

The Home map and parent submap can also be 
viewed by using the Home and Previous buttons in the 
toolbar.
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ALARMS
Table 2-1   ICON DESCRIPTIONS
EFJ System Icon: This icon represents radio and network equipment 
that are inter-connected to provide communication capability to a sin-
gle entity. Double clicking on this icon will display a map of sites 
within the system.
EFJ Site Icon: This icon represents a physical location that has net-
work equipment. Double clicking on this icon will display a map of 
all network equipment and repeaters located at the site.
Cisco 2501: A Cisco 2500-series router is represented by this icon. A 
router is a network device that routes network traffic between sites 
(or subnets).
Router: This icon may be used for a router model that does not have 
its own icon. A router is a network device that routes network traffic 
between sites (or subnets).
Computer: Site computers and channel computers are represented 
with this icon. Generically, OpenView calls it a Personal Computer.

EFJ Repeater: This icon represents a single repeater. That is a piece 
of radio equipment that is capable of receiving and re-transmitting 
radio frequencies. This icon is also used to represent channel control-
lers.

2500
2.4 MAP VIEWING OPTIONS

The scale of a map can be changed from the View 
menu and by clicking the zoom buttons in the toolbar. 
When a map is first displayed, the default size is 1 to 1 
(1:1). Maps can be zoomed to 1/2 normal size (1:2), 1/
4 normal size (1:4), or 1/8 normal size (1:8). The 
zoomed size remains in effect until changed.

If an entire map is not displayed in its window, 
select menu item View -> Pan to choose the part of the 
map to view. In the Pan dialog box, a rectangle repre-
sents the part of the map that will show in the window. 
Click on the rectangle and drag it to the desired loca-
tion. Click “OK” to view the selected area in the map 
window.

A grid (like graph paper) can be displayed on a 
map by selecting menu item View -> Show Grid. This 
menu item then changes to Hide Grid, which is used to 
turn off the grid display. The horizontal and vertical 
spacing of the grid lines can be changed by selecting 
menu item View -> Set Grid.

2.5 AN ENTRY IS DISPLAYED IN THE ALARM 
LOG

The Alarm Log displays an entry for each alarm. 
This section describes:

• Accessing the Alarm Log
• Description of the Alarm Log
• Displaying Current or History list
• Acknowledging Alarms
• Displaying selected groups (Filter dialog box)
• Descriptions of the alarms

2.5.1  ACCESSING THE ALARM LOG

Alarm information is displayed in the Alarm Log, 
which can be accessed in several ways.

• Display all alarms by clicking the Alarm Bell button 
in the toolbar or selecting menu item Monitor -> 
Alarm Log.

• Display selected groups of alarms by displaying the 
Alarm Log, clicking Filter, and selecting desired cri-
teria. (See Section 2.4.5 Displaying selected 
groups.)
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• Display the alarms for a specific icon (system, site, 
or device) by moving the cursor over the desired 
icon, clicking the right mouse button, and selecting 
Alarms. (For displaying maps and icons, see Section 
2.3 Map icons change color.) From the Alarm Log, 
the icon for the device or site that sent the alarm can 
be found by selecting the alarm entry and clicking 
the Go To button.

2.5.2  DESCRIPTION OF THE ALARM LOG

The Alarm Log information is displayed in col-
umns, as described below.

Status: A word that describes the alarm level. The 
alarm level is also indicated by the color of the entry. 
(See Section 2.5 Color status legend.)

Date: The date the alarm was reported.

Time: The time the alarm was reported.

Description: A description of the fault that caused the 
alarm. (See Section 6.2 E.F. Johnson alarms.)

Object: The system, site, or device that reported the 
alarm. The map containing the icon for an entry can be 
located by selecting an entry and clicking the Go To 
button.

The widths of the displayed columns can be 
changed by clicking and dragging the vertical bars (|) 
in the column headings.

The Alarm Log displays alarm entries in the order 
they are reported, or by order of severity (as set under 
menu item Options -> Customize Alarms. See Section 
5.4.1 Alarms.). 

2.5.3  DISPLAYING CURRENT OR HISTORY 
LIST

The History/Current button at the bottom of the 
Alarm Log is a toggle button. When the Current list is 
displayed, the button will be named History and click-
ing it will display the History list. Likewise, when the 
History list is displayed, the button will be named Cur-
rent and clicking it will display the Current list. The 
top-right area of the Alarm window will indicate if the 
Current or History list is being viewed by displaying 
“Current Display Options”, or “History Display 
Options”.

Alarm entries will stay in the Current list until 
they are acknowledged, then OpenView will move the 
entries to the History list.

2.5.4  ACKNOWLEDGING ALARMS

OpenView receives periodic status messages 
from devices. When the situation that created a high-
level alarm has been corrected, the next status message 
from the affected device will update the Alarm Log by 
moving the old entry to the History list and displaying 
the new entry in the Current list. The color of the 
Alarm Log entry and the Device, Site, and System 
icons will also update accordingly.

If a repeater re-starts, its existing alarms will be 
moved from the Current list to the History list. After 
re-start, any new alarms will be displayed in the Cur-
rent list.

To manually acknowledge or “clear” an alarm, 
click on the alarm entry in the Alarm Log, then click 
the Acknowledge button. Multiple non-consecutive 
entries can be selected with Ctrl+click. Multiple con-
secutive entries can be selected with Shift+click. All 
alarm entries can be acknowledged at one time by 
clicking the Acknowledge All button. Acknowledging 
an alarm moves the log entry from the Current list to 
the History list.

NOTE: Manually clearing an alarm is considered a 
change in status to normal level. In many cases, it may 
be advisable to not manually clear critical alarms, 
instead let them clear themselves when the problem is 
corrected (as described above). Manually clearing 
alarms will return icons to normal color, making the 
network appear to be working without problems.

2.5.5  DISPLAYING SELECTED GROUPS (FIL-
TER DIALOG BOX)

The Filters button at the bottom of the Alarm Log 
will display the Alarm Log Filters dialog box, where 
the alarms to view can be selected. When OK is 
clicked, the Alarm Log displays only the alarms that 
were selected. To again display all current alarms, 
click the Alarm Bell in the toolbar or select menu item 
Monitor -> Alarm Log.
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The top-right area of the Alarm window indi-
cates which alarms are being viewed. When viewing 
all alarms, this area reads:

Current Display Options
Show All Alarms

All Objects

The first line will read “History Display Options” 
if the History list is displayed. When viewing alarms 
filtered with the Alarm drop-down box, the second 
line will change to the alarm selected to view. When 
viewing alarms filtered by the Object Type/Object 
Name drop down boxes, the bottom line will change to 
the type-name of the selected alarms.

The drop down boxes of the Alarm Log Filters 
dialog box are described below.

Alarm: Use this drop down box to select the alarm 
description to view. The Alarm Log will then display 
alarms that have the selected description. The descrip-
tions listed are the same descriptions used in the 
Description column of the Alarm Log.

Object Type: Select the type of device from this drop 
down box. For example, if only alarms from routers 
are to be viewed, then select “router” from the list.

Object Name: To view only alarms that are from a 
specific device, select the device’s name in this drop 
down box. If a device has subcomponents, they can be 
selected by also entering the Sub(component) or Node 
numbers. Object names are shown in the Object col-
umn of the Alarm Log. The descriptive label that 
appears below a map icon is not necessarily the Object 
Name.

Object Status: Use this drop down box to select an 
alarm level. The Alarm Log will then display only 
alarms that are of the selected level. Alarm levels are 
shown in the Status column of the Alarm Log and also 
by selecting menu item Monitor -> Status Legend.

NOTE: When an icon is selected, its Object Type and 
Object Name are displayed in the status bar at the bot-
tom of the OpenView window. The format is, object 
name (object type) in submap name. They also appear 
in the Describe dialog box (right click on an icon and 
select Describe). The Object Type is the title of the dia-
log box and the Object Name is in the Name box.

2.5.6  DESCRIPTIONS OF THE ALARMS

Repeaters and channel controllers have IACs 
(Interface Alarm Cards) that can report external 
alarms, such as open doors. Each repeater can have 
different alarms. The descriptions of IAC alarms are 
found by right clicking a repeater or channel controller 
icon and then selecting Describe.

Other E.F. Johnson alarm descriptions are listed 
in Section 6.2 E.F. Johnson alarms.

2.6 COLOR STATUS LEGEND

A legend for icon colors can be seen by selecting 
menu item Monitor -> Status Legend. Colors for 
Alarm Log entries are similar. (Computer monitors 
will vary as to the exact colors seen on the screen.)

Alarm colors are described in Table 2-2. The 
highest-level alarm is listed first.

NOTE: If a color for a higher priority alarm is already 
displayed, a lower priority alarm will not change the 
color of the icon or Alarm Bell.

2.7 ACTIVE REPEATER ALARMS

To view the active alarms for a repeater, right 
click on a repeater icon and then select Active Alarms. 
Alternatively, select a repeater icon and then select 
menu item Repeater -> Active Alarms. A dialog box 
shows the repeater name and a list of active alarms, 
including active alarms that have been manually 
acknowledged from the Alarm Log.
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Table 2-2   ICON AND MAP COLORS

Status Map Log Description
Critical Red Red The device is unavailable. It may have stopped operating.
Major Dark Red Red A problem has been reported; there is some degradation 

of function.
Minor Orange Yellow A condition has been reported that may be degrading 

functions.
Warning Yellow Yellow An abnormal condition exists that is not causing degrada-

tion of function.
Marginal Mustard Yellow A problem has not occurred, but a situation is close to 

being out of specifications.
Informational Magenta Magenta Information about a situation that may be abnormal.
Disabled Cyan Cyan The device is down.
Unmanaged Wheat White OpenView does not manage the device.
Normal Green Green The device is working properly.
Unknown Blue Cyan OpenView has no information on the status of the device.
2-5
June 1997

Part No. 002-0690-201



ALARMS
2-6
June 1997
Part No. 002-0690-201



POLLING
SECTION 3   POLLING
Some alarms are the result of polling. OpenView 
will periodically check all listed devices to see that the 
network connection is working properly. When a 
change in status occurs, an alarm is processed.

Polling is controlled through menu item Monitor 
-> Polling. Controls include stop/start polling, view 
the polling list, and override default parameters.

View Polling List: Selecting menu item Monitor -> 
Polling -> View Polling List will display the View 
Polling List dialog box, which shows the list of 
devices that OpenView will poll. The list shows the 
name and address of the polled devices as well as the 
time interval between polls. At the bottom of the dia-
log box, the total number of entries is displayed and 
also whether polling is turned on or off. To remove a 
device from the list, select the device, and click the 
Remove button.

The Configure button displays the Configure Device 
Parameters dialog box that allows default values to be 
overridden for the selected device. A device must have 

an IP address to be polled. Some devices do not have 
addresses and therefore cannot be polled. <Default> 
will appear to the right of any section that is using sys-
tem defaults.

“Interval” defines how frequently a poll will be sent. 
Alarm Actions are set separately for notification of 
device down or device up. Device down means that 
the device polled did not send a response, which indi-
cates a problem. Device up means the device did send 
a response, which indicates the network connection is 
working. Select the Severity or alarm level from the 
drop down list box. Also, select whether the color of 
the map icons will be updated, whether a sound will be 
played, and if the alarm should be reported in the log.

Stop/Start Polling: This menu selection toggles to 
turn polling off and on. When polling is on, the HP 
OpenView for Windows Professional Suite version of 
OpenView animates a polling icon in the toolbar.
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SECTION 4   RECOVERY (REVERTS)
CAUTION

Reverts require extreme caution and knowledge
about the radio system. Otherwise, reverts could
cause more problems than the initial failure.

Reverts are actions that are performed if failures 
occur. Automatic actions can be configured and per-
formed through OpenView. If there is a failure, the 
remaining working pieces need to be reconfigured to 
provide the best possible coverage for the system’s 
communications needs. By setting up channel reverts 
and site reverts, OpenView can provide automatic 
reconfiguration.

Channel reverts will shut down all repeaters on a 
channel. Site reverts will shut down individual sites or 
reconfigure individual sites to stand-alone sites. If a 
repeater failure can cause both reverts, both reverts 
will occur.

Some situations will be beyond the scope of auto-
matic reverts. Therefore, it is possible to manually 
revert channels and sites. Channels and sites are 
always manually unreverted (returned to normal). 
Repeaters can also be individually controlled.

Automatic actions are configured by the System 
Manager.

4.1 CONSIDER INTERFERENCE PROBLEMS

In a simulcast system, the repeaters in adjacent 
sites are on the same channel and purposely overlap to 
fill in weak coverage areas. If one site is reverted to a 
stand-alone Multi-Net site, the overlapping areas will 
have interference problems. See Figure 4-1.

Interference problems could be minimized in sev-
eral ways. Reducing the output power level of the 
repeaters in Site 1 (Figure 4-1) might decrease the area 
affected by interference; however, it may also create a 
hole in the coverage area of the system. Reduced 
power level may also put more stations in fringe areas.

If only one repeater is not working at Site 1 
(Figure 4-1), the channel with the non-working 
repeater could be shut down. That is, the repeaters in 
sites 2 and 3 for that channel could be disabled. Except 
for having one less channel, the system would con-
tinue to function as a normal simulcast system.

If a system has enough channels, each site could 
use different channels and be reverted to a stand-alone 
Multi-Net site. The benefits of simulcast coverage 
would be lost, but the holes and fringe areas would be 
reduced.

There will be trade-off decisions that must be 
made when equipment fails. Knowing the coverage 
area of the working repeaters and considering the 
effects on the whole system will lead towards a config-
uration that minimizes the loss as much as possible.
Figure 4-1   REVERTED SITES CAN CAUSE INTERFERENCE

Site 1

Site 3

Site 2 Site 1

Site 3

Site 2

In a simulcast system, all radios 
receive the same signal.

If Site 1 is reverted to a stand-alone Multi-
Net site, radios in the black area will receive 
a signal from Site 1 and a different signal 
from Sites 2 and 3.
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4.2 CONSIDER STATUS CHANNEL AND HOME 
CHANNEL ACCESS

In simulcast systems, communications between 
radios and repeaters use Multi-Net signaling, as 
described in the Multi-Net Application Note (Part No. 
009-3039-003).

Figure 4-2 shows the relationship between repeat-
ers, channels, and sites in Simulcast and Multi-Net 
systems. Multi-Net descriptions often refer to a single 
repeater. In a simulcast system, the description would 
refer to all repeaters on the same channel.

CAUTION

Radios monitor their home channel and the status
channel for over-the-air instructions. If there are prob-
lems on either channel, radios may not receive their
instructions. Therefore, pay special attention to the sta-
tus channel and home channels when configuring
reverts.
Figure 4-2   RELATIONSHIP OF REPEATERS, CHANNELS, AND SITES

Stand-Alone
Multi-Net
System

Multi-Site
Multi-Net
System

R = Repeater
Ch = Channel

Site 1
R1
R2
R3
R4
R5

Site 2
R1
R2
R3
R4
R5

Site 3
R1
R2
R3
R4
R5

Channel 1
Channel 2
Channel 3
Channel 4
Channel 5

Simulcast
Multi-Net
System

Site 1
R1, Ch1
R2, Ch2
R3, Ch3
R4, Ch4
R5, Ch5

Site 1
R1, Ch1
R2, Ch2
R3, Ch3
R4, Ch4
R5, Ch5

Site 2
R1, Ch6
R2, Ch7
R3, Ch8
R4, Ch9

R5, Ch10

Site 3
R1, Ch11
R2, Ch12
R3, Ch13
R4, Ch14
R5, Ch15
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4.3 MANUALLY UNREVERT AND REVERT 
CHANNELS

CAUTION

Use extreme caution. Consider the effects that
changes will have on the entire system.

The revert status of channels can be seen by 
selecting a System icon and then selecting menu item 
System -> Channel Revert. A dialog box shows the 
system name, the total number of channels in the sys-
tem, and the number of reverted channels. There is 
also a list of repeater numbers, channel numbers, and 
their current revert status. If the system has automati-
cally reverted a channel, its status will be Reverted, 
otherwise the status is Normal.

The system will not automatically unrevert a 
channel. To unrevert a channel, select the channel in 
the list and click the UnRevert button. If the prob-
lem(s) that caused the revert has not been repaired, the 
channel will again automatically revert. To manually 
revert a channel, select the channel in the list and click 
the Revert button.

To unrevert individual repeaters and keep the 
channel reverted, select a Repeater icon and then 
select menu item Repeater -> UnRevert. Repeaters can 
also be reconfigured by using the Manual Repeater 
Control dialog box covered in Section 4.7. The chan-
nel status will remain reverted and additional alarms 
on the channel will not revert the channel.

4.4 CHANNEL UNREVERT EXAMPLES

The information in this section is for example 
only and may or may not apply to a specific system. 
Each system should be analyzed for other situations 
that may benefit from automatic reverts.

NOTE: If a channel that has failed repeaters is unre-
verted, radios that receive data from the sites that have 
failed repeaters will not hear calls made on the unre-
verted channel. Remember to consider the condition of 
home channels and the status channel when unrevert-
ing channels.

A simulcast system can be configured to automat-
ically shut down all repeaters that are on a channel that 
has simulcast failure, repeater failure, or RNT/CIM 
Channel Problem alarms. Channel reverts are config-
ured by the System Manager. Channels are unreverted 
using menu item System -> Channel Revert (as 
described in Section 4.3).

• Low-Usage Area with Failure

If a system has reverted a channel because of a fail-
ure at a site in a low-usage area, the channel may be 
unreverted to provide high-usage areas with all 
channels. Radios receiving data from the site with 
the failed repeater will not hear calls made on the 
unreverted channel.

• Status Channel with Failure

If the status channel is reverted, unreverting it will 
optimize system response at sites with no failures. 
Radios in coverage areas with status channel fail-
ures will still receive update information on their 
home channels. No calls will be heard on the status 
channel from sites with failed repeaters.

The status channel can be configured to never 
revert.

• More Failures Than Channel Revert MIN

If the system has reverted as many channels as it can 
(as defined by Channel Revert MIN), additional 
failures on other channels will not cause channel 
reverts. Channels are reverted in the order that 
OpenView receives the alarms; however, if Channel 
Revert MIN is reached and there are more problems, 
it may be wise to unrevert some channels and revert 
others.

For Example: A system may revert a home channel; 
then, a non-home channel has problems but is not 
reverted because the system has already reverted the 
number of channels that it is automatically allowed 
to revert. In this case, the system may work more 
efficiently if the home channel is manually unre-
verted and the non-home channel is manually 
reverted. Radios on the unreverted home channel 
that receive data from the site with the failed 
repeater will not receive data from the home chan-
nel, but they will still receive data from the status 
channel.
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4.5 MANUALLY UNREVERT AND REVERT 
SITES

CAUTION

Use extreme caution. Consider the effects that
changes will have on the entire system.

To see the revert status of sites, select a System 
icon and then select menu item System -> Site Revert. 
A dialog box shows the system name, the total number 
of sites in the system, and the number of reverted sites. 
There is also a list of sites and their current revert sta-
tus. If the system has automatically reverted a site, its 
status will be Reverted, otherwise the status is Normal.

The system will not automatically unrevert a site. 
To unrevert a site, select the site in the list and click 
the UnRevert button. If the problem(s) that caused the 
revert has not been repaired, the site will again auto-
matically revert. To manually revert a site, select it 
from the list and click the Revert button. Alternatively, 
sites can be reverted and unreverted by selecting a Site 
icon and then selecting menu item Site -> Revert or 
Site -> UnRevert.

To unrevert individual repeaters and keep the site 
reverted, select a Repeater icon and then select menu 
item Repeater -> UnRevert. Repeaters can also be 
reconfigured by using the Manual Repeater Control 
dialog box covered in Section 4.7. The site status will 
remain reverted and additional alarms at the site will 
not revert the site.

4.6 SITE REVERT EXAMPLE

The information in this section is for example 
only and may or may not apply to a specific system. 
Each system should be analyzed for other situations 
that may benefit from automatic reverts.

If the home channel of an important group of 
users and the Status Channel both fail at a Site, the site 
can be automatically reverted and reconfigured to 
allow communications within the site. If a system has 

very large overlap areas, the affected site might be 
shut down without greatly degrading coverage. How-
ever, if shutting down the site would leave large areas 
inaccessible, reconfiguring the site to a stand-alone 
Multi-Net site may be a better alternative.

NOTE: Subscriber units on the system will need to 
have a “backup” system programmed for a stand-
alone Multi-Net site. When the fleet map is produced 
for the subscriber units, the site revert actions and the 
backup system must be planned together.

CAUTION

Radios monitor their home channel and the sta-
tus channel for over-the-air instructions. If there
are problems on either channel, radios may not
receive their instructions. Therefore, pay special atten-
tion to the status channel and home channels when
configuring reverts.

The following example shows how a 3-site, 10-
channel system could be configured for an automatic 
site revert.

Refer to Figure 4-3. Site 3 has been configured to 
revert to a stand-alone Multi-Net Site if repeaters 1 
and 3 fail. In this system, repeater 1 is the Status Chan-
nel. Repeater 3 is the Home Channel for the Group 
used by a high-priority collection of users. When 
repeaters 1 and 3 fail, Groups that use channel 3 as the 
Home Channel have no access to the radio system in 
the Site 3 coverage area. When the system reverts, 
Groups that use a backup subscriber unit system will 
have local access for Site 3; other groups will have no 
access for Site 3.

When the high-priority users need to use the 
repeater at Site 3, they will need to change their radios 
to a backup system that is programmed (in this exam-
ple) with repeater 8 as the status channel. Repeater 9 is 
the Home Channel for their Group. Trunked communi-
cation will then be available to them within the Site; 
however, no audio is sent back to the RNT. Therefore, 
there will be no consoles, unique ID calls, or telco 
calls from Site 3.
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Figure 4-3   SITE 3 IS CONFIGURED TO REVERT TO A STAND-ALONE MULTI-NET SITE.

Channel 1
Site 1

R1
R2
R3
R4
R5
R6
R7
R8
R9
R10

Site 2
R1
R2
R3
R4
R5
R6
R7
R8
R9
R10

Site 3
R1
R2
R3
R4
R5
R6
R7
R8
R9
R10

Channel 2
Channel 3
Channel 4
Channel 5
Channel 6
Channel 7
Channel 8
Channel 9
Channel 10

Channel 1
Site 1

R1
R2
R3
R4
R5
R6
R7
R8
R9
R10

Site 2
R1
R2
R3
R4
R5
R6
R7
R8
R9
R10

Site 3
R1
R2
R3
R4
R5
R6
R7
R8
R9
R10

Channel 2
Channel 3
Channel 4
Channel 5
Channel 6
Channel 7
Channel 8
Channel 9
Channel 10

Channel 1
Site 1

R1
R2
R3
R4
R5
R6
R7
R8
R9
R10

Site 2
R1
R2
R3
R4
R5
R6
R7
R8
R9
R10

Site 3
R1
R2
R3
R4
R5
R6
R7
R8
R9
R10

Channel 2
Channel 3
Channel 4
Channel 5
Channel 6
Channel 7
Channel 8
Channel 9
Channel 10

Status
Home

Normal 3-site, 10-channel simulcast system.

At site 3, repeaters fail on the status channel (Channel 1) and
on the home channel for a high-priority group (Channel 3).

The system was configured to automatically revert site 3 to a stand-alone
Multi-Net site using repeaters 8, 9, and 10 and shutting down repeaters
1 through 7. To avoid interference, systems with large overlap areas may
also need to manually shut down repeaters 8, 9, and 10 at sites 1 and 2.
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4.7 PERFORM MANUAL REPEATER CONTROL

CAUTION

Use extreme caution. Consider the effects that
changes will have on the entire system.

Since each system has a unique installation and 
unique propagation patterns, some situations will be 
beyond the scope of automatic reverts. Therefore, it is 
possible to manually set the repeater mode and power 
level for each repeater and also set if the repeater is on 
the Status Channel. Repeater control is done by select-
ing a System icon and then selecting menu item Sys-
tem -> Manual Repeater Control. The Manual 
Repeater Control dialog box will appear.

This dialog box shows the name of the system 
and a list of all sites/repeaters within the system. The 
repeaters can be shown/hidden by clicking the +/- but-
ton next to the site name or by double clicking the site 
name. For each repeater, the mode, power level, and 
whether the repeater is on the Status Channel are 
shown.

The Current column shows if the information is 
“True” or “False”. True indicates the conditions at the 
present time. False indicates that there is a communi-
cation problem with the repeater, so current informa-
tion is unavailable.

To make changes, select the repeater to change, 
select the desired options, and then click either the Set 
Mode button, the Set Power button, or the Set Mode 
and Set Power button. The repeater will be repro-
grammed and the dialog box will be updated accord-
ingly.

• Repeater Mode

This section is used to select the trunking method of 
the repeater and whether the repeater is on the Status 
Channel.

Disabled: The repeater will be shut down. It will not 
transmit or receive in any mode.

Stand-Alone Multi-Net: The repeater will use 
Multi-Net signaling, but will not communicate with 
any other radio sites (Multi-Net sites or other sites) 
within the system. The enhanced operating features 
provided by Multi-Net signaling will not be avail-
able.

Simulcast Channel Control: Select this option if 
the “repeater” is part of the channel controller in a 
simulcast system. A channel controller makes sev-
eral simulcast remote repeaters look like one 
repeater to the RNT (Radio Network Terminal, 
which controls the operating features of the radio 
system).

Simulcast Remote Repeater: Select this option for 
any repeater that is part of a simulcast system. A 
simulcast system has several sites. Each site in a 
system has the same channels and the channel audio 
is rebroadcast at each site.

Status Channel: An x in this box designates that the 
repeater is on the Status Channel. The Status Chan-
nel transmits update information for all calls. There 
is only one Status Channel in a simulcast system. 
Although, a site configured as a separate stand-
alone site may have a different Status Channel.

• Power Level

Select the desired transmit power level.

4.8 REPEATER MENU

Repeaters can also be controlled by selecting a 
repeater icon from the map and then selecting a func-
tion from the Repeater menu. The following functions 
are available.

Active Alarms: To view the active alarms for a 
repeater, select a repeater icon and then select menu 
item Repeater -> Active Alarms. A dialog box shows 
the repeater name and a list of active alarms, including 
active alarms that have been manually acknowledged 
from the Alarm Log.

Restart: A repeater can be restarted by selecting a 
repeater icon on a map, and then selecting menu item 
Repeater -> Restart.

Revert: To revert a repeater, select a repeater icon on a 
map, and then select menu item Repeater -> Revert. 
The repeater will be reverted to the configuration set 
in the Revert Action Configuration dialog box (a sys-
tem manager function).

UnRevert: To unrevert a repeater, select a repeater 
icon on a map, and then select menu item Repeater -> 
UnRevert. Unrevert returns the repeater to the config-
uration set in the EFJ Repeater Description dialog box 
(a system manager function).
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SECTION 5   OPENVIEW OPTIONS
5.1 LOG IN AND LOG OUT

Menu item Options -> Log Out disables access to 
all OpenView functions except menu items Options -> 
Log In and Help. To regain access, select menu item 
Options -> Log In and enter the required password.

5.2 PROTECT/UNPROTECT MAP

Maps are protected to avoid accidental changes. 
To unprotect the maps, select menu item Options -> 
Unprotect Map and enter the required password. When 
maps are unprotected, an operator can open new maps 
by selecting menu item File -> Open. To protect maps, 
select menu item Options -> Protect Map and enter a 
password. Verify the password by entering it again in 
the next box. This menu item is a toggle between 
unprotecting and protecting maps.

5.3 CUSTOMIZING OPENVIEW

OpenView may be customized by selecting menu 
item Options -> Customize HP OpenView.

These options should only be changed under the 
direction of the System Manager.

5.4 CUSTOMIZING ALARMS

Alarm processing may be customized by select-
ing menu item Options -> Customize Alarms.

5.4.1  ALARMS

Frequency: The default is 0 seconds. OpenView 
reports all alarms from E.F. Johnson components (such 
as repeaters) to the Alarm Log and updates the color of 
the icons. If set to a higher value, identical alarms that 
are received within the time frame will not be 
reported. After the time frame has expired, notification 
of the alarm resumes.

Delete after: The default is 7 days. OpenView will 
automatically delete History Alarm Log entries that 
are more than 7 days old. The deletion will take place 
when OpenView is started or at midnight if Open-
View is running.

Sort by: The default is “Time”. The entries in the 
Alarm Log will be displayed in reverse chronological 
order (newest at the top of the list). Selecting “Status” 
will display the entries according to severity (most 
severe or highest status level at the top of the list) and 
according to time within each alarm level.

5.4.2  ALARM SOUND

Select Disable Sounds, Sound Once, or Repeat.

Disable Sounds: No sounds will be heard when 
alarms are displayed.

Sound Once: The alarm sound will sound once when 
an alarm is displayed.

Repeat: The alarm sound will be repeated until the 
alarm clears. A time interval (Every __ minutes) 
between 0 and 999 can be set to define how often the 
sound is repeated. The “For status” entry sets which 
level of alarms will receive the repeated sound. For 
example if set to “Major”, only major and critical 
alarms will have repeated sounds; all other alarms will 
sound only once. (See Section 2.5 Color status leg-
end.)

By default the alarm sound will be the system 
beep. For a system that is capable of playing sound 
files, sound files can be associated with each alarm 
through the Sound dialog in the Windows Control 
Panel.
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5.4.3  STATUS PROPAGATION

Maps are linked hierarchically. The top level is a 
System map, the middle level contains Site maps, and 
the bottom level contains Devices maps. This option 
defines if alarms are shown on maps that are at a 
higher hierarchical level than where the alarm 
occurred.

The default is “Pass status up all levels”.

Pass status up all levels: With this setting, an alarm 
will be passed to all higher hierarchical maps to dis-
play a colored icon for alarm notification. For exam-
ple, if a device reports an alarm, the following icons 
will change color 1) the Device icon, 2) the Site icon 
where the device is located, and 3) the System icon. (If 
there is already a higher level alarm at the site and sys-
tem level, the icon will remain the color of the highest 
alarm.)

Pass status up one level: Alarms will only be passed 
up one level in the hierarchy. With this setting, a Sys-
tem level map will not show that a Device level map 
has an alarm.

Do not pass status up: The alarm will only show on 
the map where the alarm occurred.

5.4.4  ALARM FORWARDING

Alarms can be forwarded to another console. This 
should only be set under the instructions of a System 
Manager.
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SECTION 6   TROUBLESHOOTING
6.1 PING

6.1.1  PING TROUBLESHOOTING TECH-
NIQUES

Ping (packet Internet groper) sends a message to 
a device and waits for a response. The response will 
indicate that the network connection is working or that 
a problem was detected. The ping messages and 
responses are ICMP (Internet Control Message Proto-
col) echo messages and their replies.

If the device pinged does not respond, there could 
be a problem in several areas. Figure 6-1 shows the 
path of a ping from the host computer to a site com-
puter. If the site computer does not respond, trying to 
ping the other addresses may show that the problem is 
somewhere between the host computer and the site 
computer.

To verify that the IP stack in the current device is 
functioning properly, ping address 127.0.0.1. (The cur-
rent device is the device that sends the ping message.)

6.1.2  PING PROGRAM OPERATION

Ping is controlled by moving the cursor over the 
desired map icon, clicking the right mouse button, and 
selecting Ping. Alternatively, select a map icon and 
then select menu item Monitor -> Ping.

The Ping window is used to start/stop pings and 
set ping options. The bottom of the window shows the 
number of pings sent, the number of pings received, 
and the percentage of data lost. These numbers are 
reset to zero when a ping is started.

Start/Stop pings: This is a toggle operation that is 
selected by clicking the menu item Start or Stop, in the 
Ping window. Alternatively, click on the hexagon 
(stop-sign shaped) red (for stop) or green (for start) 
button.

If a response is received from the device, a mes-
sage similar to the following will appear in the Ping 
window.

reply from 100.100.103.2: sequence = 0 round-
trip time = 30 ms

round-trip min/avg/max = 30/30/30 ms

The first line includes the network address of the 
pinged device (100.100.103.2), the number of the ping 
(sequence = 0), and the time it took between when the 
ping was sent and the response was received (round-
trip time = 30 ms). If the continuous option has been 
selected, the sequence number will increase for each 
ping.

The second line shows the minimum, average, 
and maximum times for round-trip.

If a device is pinged and no response is received, 
a message similar to the following will appear in the 
Ping window.

1 packet transmitted, 
0 packets received 100% packet loss
Figure 6-1   TROUBLESHOOT BY PINGING SEVERAL IP ADDRESSES

Host Computer Site ComputerRouterRouter
100.100.201.200 100.100.202.100

100.100.202.1

100.100.102.2

100.100.201.1

100.100.102.1
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Ping Options: Customize pings by selecting Options 
in the Ping window menu. If Continuous Operation is 
unselected (default), selecting Start ping will ping the 
device once. If Continuous Operation is selected, 
selecting Start ping will repeatedly ping the device 
until Stop ping is selected. Ping time out is set in milli-
seconds and defines the amount of time OpenView 
will wait for a response from the pinged device.
6.2 E.F. JOHNSON ALARMS

6.2.1  REPEATER GENERATED ALARMS

* Consoles will not receive audio from the affected channel. The channel will still be operating, unless it was shut 
down by an automatic channel revert.

6.2.2  SITE/CHANNEL COMPUTER GENERATED ALARMS

Repeater in Test Mode IAC Input 1
IAC Input 2 IAC Input 3
IAC Input 4 Reserved (5)
Reserved (6) Reserved (7)
Reserved (8) MAC Processor
HSDB Processor IRDB Cable
RNT/CIM Channel Problem* TIC Processor
SMC Processor VNC
AC Power Fail Battery Power Fail
Power Supply Thermal Fan 1 Current
Fan 2 Current IAC Mismatch
GPS 1 PPS SMC Link
No A/D Samples GPS 10 MHz
Repeater in Setup State RF Shutdown (several modes)
RF Half Power Mode Thermal Sense in RF Portion
RF Finals 1 and 2 RF Finals 3 and 4
RF VSWR Normal Synthesizer Tx Lock
Normal Synthesizer Rx Lock HS Synthesizer Tx Lock
HS Synthesizer Rx Lock RF Quarter Power
Repeater Disabled

SCS in Test Mode SIB Link Alarm
Simulcast Failure Repeater Failure
Site Reverted Unable to Configure Repeater
Unconfigured Repeater
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6.2.3  HOST COMPUTER GENERATED 
ALARMS (FOR THE SITE/CHANNEL COM-
PUTERS)

HC-SCS Network Link Established
HC-SCS Network Link Lost
HC-SCS Connection Attempt Failed

6.2.4  HOST COMPUTER GENERATED 
ALARMS (FOR THE REPEATERS)

Repeater Restarted
SMC Configuration Finished
SMC Configuration Failed
Repeater Configuration Finished
Calibration Write Failed
Calibration Write Finished

6.2.5  HOST COMPUTER GENERATED 
ALARMS (FOR A SYSTEM)

Channel Reverted
Channel Unreverted

6.3 MNEMONICS

A/D - Analog to Digital
CIM - Channel Interface Module
GPS - Global Positioning System
HC - Host Computer
HSDB - High-Speed Data Bus
IAC - Interface Alarm Card
IP - Internet Protocol
IRDB - Inter-Repeater Data Bus
MAC - Main Audio Card
MBC - Message Bridge Card
PPS - Pulse Per Second
RNT - Radio Network Terminal
SCS - Site Controller Station or Site/Channel 

computer
SIB - Serial Interface Bus
SMC - Simulcast Modulation Card
SNMP - Simple Network Management Protocol
TCP - Transmission Control Protocol
TIC - Telephone Interface Card
VNC - Viking Network Controller
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